Digital Best Practices:

Keys to successful Design
Simple. Bold. Legible. Brief.
Though digital billboards show an ad for approximately 7 to 10 seconds, those that are most effective should be
“devoured” in three seconds. Build the message based on the three-second rule. Narrow the focus and decide what your
message will be. Make it concise. The message can be one of the following:
• A person
• A national brand
• A Web site

• A Service
• A call-to-action
• A location

• A product
• A price
• An event

• A local brand
• A special promotion

Effective.

Ineffective.

• Placement of the car
moves the eye naturally
to the information.

• Too many design
elements compete for
visual importance.

• Excellent use of color
contributes to the
legibility.

• Too much color
confuses the customer.

• Fewer design elements clarify the message.
• Web site encourages consumer to take action.

•A specific time: Morning,
Noon or Evening

• Poor car placement does not encourage the eye’s
natural flow.
• The local brand (Miles) and national brand (Chevrolet)
are buried in the text.

Graphic designers solve visual creative problems using these basic principles:
The information in this guide will help you understand the use of these three basic design principles for creating digital
display content that wins the glance and entices your client’s customers.

1. Composition

2. Typography

3. Color
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Digital Best Practices:

Composition
Define Layout

Layout is the design principle that determines the finished look of an advertisement. The most important principle for
creating effective outdoor content is visual prioritization of the message, or hierarchy of communication. Consumers
can’t hear and understand four messages at once; they can’t see and understand four messages at once, either. Define
the items (ABC levels) you want to communicate and prioritize each piece in order of importance according to the
following information.
People read in chunks of information. They scan across, then down, and pick up information in logical sections. The
more distinct those sections of information, the faster people interpret the meaning or the purpose of the message.
Visual and written information that overlap cause the reader to pause and sort the two apart before understanding the
message. Using hierarchy of communication helps speed comprehension and increases retention of the message.

Tip:
Ask your audience to take action,
such as “call today.”

Visual Priority

Visual Clutter
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Digital Best Practices:

Composition

Hierarchy of Communication
Use the levels as guidelines to first capture the viewer’s attention with a clear, single point of communication. Then give
the viewer definition or detail that points back to the first level. Finally, give them the information they need to inspire
an emotion, an action, or a purchase.

Level A: A photo, logo, service, product image or price.
Whichever is the most important piece of information.

Level B: Supporting information that gives definition or
detail to support level A.

Level C: Relevant information that tells the customer where,
how or who to contact for the information in levels A and B.

Traditional vs. Digital Advertising
Some worry they will not be able to get all of their
information on one frame or piece of artwork. So they
add every possible detail they can think of. This mindset
derives from traditional print advertising.
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Digital Best Practices:

Typography

Define Typography
Typography is the arrangement and appearance of type on a page.

Readability: Select easy-to-read typefaces. Large, bold fonts make it easier for your
audience to read and comprehend text from different viewing distances. In addition,
text using all capital letters is harder to read. Use text made up of both upper- and
lower-case letters.

Selecting Effective Fonts

Regular Text

Bold Text

Select fonts that are easy to read from different viewing distances, such as large, bold
fonts. Remember to use text containing both upper and lower-case characters when
you have a long message. Using text with all caps should be limited to short messages.
Using a limited amount of text will help viewers’ readability and comprehension.
Examples of these variations on text are below.

All Cap Text

Tip:
When possible, after creating the ad, look at the
content on the actual digital billboard display to make
sure it’s easy to read.
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Digital Best Practices:

Typography

Make it a Campaign
Digital advertising needs to be created differently than
traditional print magazine/newspaper advertising because of
the unique capabilities of the medium. Print advertising has
one chance to convey all necessary information to customers,
whereas digital advertising can show several messages in
a series of rotations giving advertisers multiple chances to
convey the necessary information to customers.
Digital Display Management allows multiple clients to
advertise separately on a digital billboard. The web-based
software easily updates and automatically rotates through
a series of individual clients’ digital advertisement slots. The
slot belonging to one advertiser may also have unique digital
content showing at each rotation. This provides a better
chance to attract the attention of different demographics and
promotes campaigns of ads with small amounts of text (i.e.
information) instead of a single text heavy advertisement.

Digital Advertising Design

Traditional Print Ad Design

Examples of Digital Campaigns:
A campaign of digital advertisements for a zoo with each ad containing similar
design characteristics. The information is broken into five separate ads,
making it easier for viewers to comprehend on a digital billboard rotation.

Tip:
When using a colored background, outlining the letters in black and using
drop shadows can create interest and increase readability.
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Digital Best Practices:

Color

Define Color
Take full advantage of your display’s color capability by using rich,
vibrant colors. Bright, saturated colors (colors with no white in them)
work better than pastel or low-contrast colors.
The color wheel to the right features a full color range.
Certain colors tend to evoke specific emotions or ideas, so choose
them carefully to help support products and ideas. See chart below.

COLOR

Emotions Evoked

RED

Stimulating, exciting, provocative, dynamic

RED ORANGE

Domination, aggression, and action

ORANGE

Friendly, vital, playful, energizing, inviting

YELLOW ORANGE

Illumination, wisdom, and wealth

YELLOW

Sunny, warming, cheerful

Yellow green

Sickness, cowardice, discord, and jealousy

Green

Soothing, nature, refreshing, healing, fresh

Blue Green

Emotional healing, protection

Blue

Cool, quiet, serene, constant

Blue Violet

Uniqueness, preciousness, royalty, and sacredness

Violet

Creative, regal, spiritual, mysterious

Red Violet

Energetic, happy, sweet, romantic, youthful

Black

Strong, classic, elegant, mysterious
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Digital Best Practices:

COLOR

Use Tonal Contrast
Using contrast is vital to your design because
it helps the viewer distinguish between design
elements. For best contrast, use tonal contrast (or
value difference) instead of only color difference.
Tonal contrast can be measured by using
compositing software such as Adobe® Photoshop®.
Simply open your advertisement using your
preferred compositing software and then convert
it to gray scale. You can now easily measure the
advertisement’s tonal contrast. An example of this
is shown on the right.

Good
Contrast

Bad
Contrast

Bad
Contrast

Color

Greyscale

The bottom image uses hues of red and green that have the same tonal value (bad contrast). It is difficult to distinguish
between background and text. This produces an effect called “vibrating.” After converting content to gray scale with
compositing software, the advertisement’s tonal contrast is apparent.

Good Tonal Contrast
Tip:
After turning your content to gray
scale, is your advertisement still
readable? Do all of your elements
stand out? If so, your content piece
has good tonal contrast.

wvoutdoor.com | 8

Digital Best Practices:

COLOR

Using Contrasting Colors
Select colors that provide good contrast to make your content
more appealing and easier to read. Achieve effective contrast by
using colors with different values (how bright or dark a color is).
Use the chart at the right to guide your design. You can see that
yellow is a bright color with a very light-gray value. Purple, on the
other hand, is a dark color with a black value. Therefore, using
yellow and purple together provides very good contrast.
By looking at the chart again, you can see that yellow and green
aren’t the best colors to use together because the contrast
between the two is so low. Solve this problem by using a darker
green that has a darker value to increase contrast and readability.

Color

Value

Value Range
of Red

=
=
=
=

The value range chart on this page shows you how each color (in
this example we used red) has a number of values to choose from. This makes contrast easy to achieve.

Tips:
Remember the product user must be able to see the artwork, scan for details, and
make an assessment of the data. Do not overwhelm them with visual clutter.
Choose a color or graphic that supports your essential message. In this case, blue
implies cool or cold and orange is inviting and energizing; just what you need in the
morning.
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Digital Best Practices:

COLOR

White Backgrounds
Avoid White Backgrounds: With LED technology,

the use of emitted light, white or very light colors may
repel the eye—not the desired response in advertising.
A grave concern in most regulatory environments is
offensive use of light or white content. Even though
digital displays are fully capable of producing white and
pastel colors it is not recommended. Taking advantage
of the color capabilities is thoughtful and in general
more pleasing to the eye. If white or pastels must be
used, the content should only be scheduled for daytime
viewing.

Black Backgrounds: For digital billboards, black is
the absence of color. Black is created with the use of less
light. White is the blending of all colors and the use of
more light in digital billboards.
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Digital Best Practices:

COLOR

Standard Colors
Make your digital content pop with colors that work. Find information below about the RGB (red, green and blue) colors
that look the best on a digital display. Choose these colors when building digital content/artwork/advertisements to take
advantage of the full-color capabilities of your cutting-edge digital billboard.

True Colors

Red
R=255
G=0
B=0

Green
R=0
G=255
B=0

Blue
R=0
G=0
B=255

Yellow
R=254
G=233
B=0

Orange
R=255
G=88
B=0

Purple
R=182
G=52
B=187

Other Colors

Yellow
Orange
R=255
G=182
B=15

Light
Orange
R=255
G=161
B=0

Sunshine
R=252
G=217
B=0

Orange
R=255
G=121
B=0

Red
Orange
R=255
G=88
B=0

Coral
R=255
G=109
B=66

Warm Red
R=247
G=64
B=58

Red
R=205
G=32
B=44

Medium
Red
R=198
G=12
B=48

Salmon
R=245
G=63
B=91

Pink
R=236
G=67
B=112

Rose
R=202
G=0
B=93

Ruby Red
R=202
G=0
B=93

Rhod Red
R=224
G=17
B=157

Purple
Pink
R=195
G=0

Dark
Purple
R=87
G=6

Violet
R=75
G=8
B=161
B=158

Royal Blue
R=37
G=38
B=169
B=140

Medium
Blue
R=15
G=77
B=188

Dark Blue
R=0
G=35
B=149

Aqua
R=0
G=115
B=207

Pro Blue
R=0
G=136
B=206

Grey Blue
R=0
G=101
B=189

Sky Blue
R=0
G=122
B=201

Apple
Green
R=0
G=175
B=63

Forest
Green
R=0
G=121
B=52

Grass
Green
R=88
G=166
B=24

Lime
Green
R=146
G=212
B=0

Canary
R=234
G=223
B=0

Gold
R=233
G=233
B=0

Dandelion
R=228
G=215
B=0

Burnt
Umber
R=181
G=163
B=0

Dark Gold
R=193
G=187
B=0
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Digital Best Practices:

Tips for success

Tips & Techniques for Digital Billboard Content Success
Start with a red, green, and blue color space, also known as RGB, the standard digital technology. This is the same mode
as your TV or computer. Cyan, magenta, yellow and black, also known as CMYK, unlike RGB, are used for high resolution
printing. When creating contest for digital signage, images must be created in RGB. Use the following tips to create files
that work best for digital signage.

Color Mode
Photoshop Tips:

Illustrator Tips:

Is your file CMYK or RGB?
• Look at the title bar.
• The color mode is next to the file’s name.
• The color mode should be RGB/8 bit.

Is your file CMYK or RGB?
• Look at the title bar.
• The color mode is next to the file’s name.
• The color mode should be RGB.

Creating a new file:
• File > New
• In color Mode drop-down menu, select RGB.

Creating a new file:
• File > New
• Select RGB radio button.

Converting from CMYK to RGB:
• If the image has layers, you will be given the option
of flattening your image when converting to RGB. The
best practice if you already have a CMYK image is to
finish in that color mode, then convert to RGB and
flatten the layers when possible. Note: colors may shift
when converting from CMYK to RGB.
• To convert a flattened image (1-layer), go to Image >
Mode > RGB color.

Converting from CMYK to RGB:
• File > Document Color Mode > RGB Color
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Digital Best Practices:

Tips for success

Tips & Techniques for Digital Billboard Content Success
• Build content in its native measurement (pixel by pixel - not inch by inch) Example: 888 w x 260 h.
• Save files as JPEGs
• 72 ppi is recommended for resolution for this technology.

File Size
• Under “My computer,” identify the
image you wish to check. Right click on
the .jpeg image.
• Click on “properties.” This will show the
properties of the image you created.
• The file size should be listed in the
middle of the panel.
• The file size should be around
70-150KB.

Photoshop Tips:
Compressing File Size:
• Open the file in Adobe Photoshop.
• Choose “save as.” Rename your file. Choose .jpg format.
• A window will come up. Move the slider bar in the center to
the left in order to compress the file size.
• Use the “file size” instructions, left, to view file size. If it is still
too big, repeat the directions above.

Illustrator Tips:
Compressing File Size:
• Open the file in Adobe Illustrator.
• Choose “save as.” Rename your file. Choose .eps format.
• This will compress the file size.
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Digital Best Practices:

Tips for success
Importable Image Files

• Choose photos to import that have a smooth gradation (smooth change from one color to another) of color shades
and don’t contain much detail.
• You may need to change the size of an image to fit your display and then crop it so it will look its best.
• For the most attractive images, use those in raster format (.jpg, .png, .gif, .bmp, and .tif) and set them at 72 ppi.
• Logos appearing on a black or colored background will be more effective than logos on a white background.

Image for Digital Advertisement
Tip:
Add interest—show only a portion
or the focal point of an image.
Examples left.

Focal Point of the Image
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Tips for success

Examples of Dynamic Content
Dynamic content is defined as the ability to automatically update data within a creative template utilizing a RSS feed.
Interact with audiences by displaying interactive content, such as time and temperature, the artist and song on a
featured radio station, hospital ER waiting times, and live feeds. Talk to your representative about our dynamic
content options.

Creative Template

Creative Template with Data
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